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How to quantify the impact of the
Kineta wildfire?

Before A | Afte .

Kineta, Greece | 2018-07-15 ,
Colour Infrared Imagery (NIR/FisdGreen Bands Kineta, Greece | 2018-07-30
[Colour Infrared Imagery (NIR/Red/Green Bands) < ("

In this exercise we will learn:
- Detection of burned areas and quantification of burn severity.
- Developing a graph for automated processing: Batch processing
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Getting S2 data

* Copenicus Open Access Hub:

Before fire:

S2A_MSIL2A 20180703T092031_N0208 R093 T34SFH 20180703T121025.SAFE
After fire:
S2A_MSIL2A 20180730T090551 N0208 R050 T34SFH_20180730T120425.SAFE

S2 data also available in folder:
PECS_Slovakia/Fires/S2_L2A_images
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Let’s have look to the before & after images

Open RGB Image Window:

Select: MSI Atmospheric penetration

* Window-> Tile horizontally, zoom in
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Let’s create a cloud mask

* Go to Mask Manager, and scroll down to the Maths masks
* Select: cloud medium & cloud high probability & Thin cirrus
* To visualize them better, lower the transparency (e.g. 0.1)

|
File Edit View Analysis Layer
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| :scl_veg . :Maths - 0.5|Vegetation [
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_[Maths - 0.5|Unclassified |
Maths = || 0.5/Cloud (medium probability) |
‘Maths [ ] 0.5|Cloud (high probability) \
g ‘Maths : 0.5(Thin cirrus i
..Maths 7| 0.5|Snow or Ice -
»
X' =Y ™= ‘ Lat - Lon =

©

Zoom - Level —

-
o
<
a
-
=
o
=]
o
a
@
o~

ol

Jabeuep ysep

5/31



We make a cloud band based on the
selected mask

* Band math expression

SNAP
File Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help Q-
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[scl_not_vegetated | | f——————1iscl_cloud_high_proba or scl_thin_cirrus| omwy-‘, 9.3[Technical guallty mask - M5 deoi) % E
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4] I X (?)

X -~y - | Lat - lon - Zoom - Level -

1:164.62

e Name the new mask: clouds
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Adding the cloud mask as a band

* On the image, right click-> Band Maths
 Make sure to deactivate “Virtual”. We want to store the data!
* Go to “Edit Expression”
e Select Clouds
E! Band Maths |t (el :;éq

Target product:

|[1] S2A_MSILZA_20180703T092031_N0O208_R093 T34SFH_20180703T121025 ‘v‘

Name: .clcud_ mask |

Description: [ |

Unit; ' |
tral wauelength'-ﬂ 0 |

ual (save expression only, don't store data)

Band maths expression:

Load... Save, Edit Expression... ‘

| QK | Cancel | Help ‘

H Band Maths Expression Editor

Product: | [4] 524_MSIL2A_20180730T090551_N0208_R0S0_T345FH_20180730T 120425

Data sources: _ e —,
$4 _scl_not_vegetated - 2+ 3 $4.clouds|
$4.scl_water
= @ - @
$4.scl_unclassified
o e = 5 @ % @
$4.5c1_cloud_nediun proba
$4.scl_cloud_high_proka -
$4.8cl_thin_cirrus .
= = = (@)
$4.8cl_snow_ice g ¢
p— CONSTants. . -
$4.clouds - )
Srators. . .
Show bands s =)
Functicona -

Show masks

Show tie-peint grids

98 &

Show sindle flags

Ok, no errors.

[ oK ” Cancel

[
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Vizualize all products

* Windows: Tile evenly
* Navigation: zoom all
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Batch processing: Graph building

—
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o B [1] S2A_MSIL2A_20180703T092031_N0208_R093_T345FH_20180703T1210 i
¢ = [2] S2A_MSIL2A_20180730T090551_N0208_RO50_T345SFH_20180730T1204 El
o [0 Metadata -
o [@ Index Codings r E—
o (O Vector Data 3
o (31 Bands
“a T .
Add ¥ L Input-Output » =
Connect Graph | 03 Optical » [
P 2
 Radar b ]
G Raster » :
k Tools » a2
a
s Vector »
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Navigation - ... X | Colour Manipul... |Uncertainty Vis. World View =) p- 2
= . | a
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@, | [Read [ write
Q Source Product
@ Name
[2] S2A_MSIL2A_20180730T090551_N0208_RO50_T34SFH_20180730T120425 -
% Data Format: Any Format -
E Load | 3 Save 6’ Clear ‘ 1/1) Note ‘ @' Help l Run
1:34637 | =L} 0 =12
X - Y - Lat —= Lon - Zoom - Level —

e Add->Raster->Geometric->Resample
e Add->Raster->Geometric->Subset
e Add->Raster->BandMaths

Add->Raster->BandMerge
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ave the graph

E. Graph Bullder Rl
File Graphs
a
BandMaths
| Read Hm:sampleH Subset :lHerge —
bl
0 | »
e : ; - ;
[ Rea§ [ Write |’Resamp|e | Subset | BandMaths | BandMerge ]
Source Product
Mame:
|[2] S2A MSIL2A 20180730T0S0551 NO208 RO50 _T345FH_20180730T120425 lv|
Data Format: Any Format [V|

Expression is invalid.

5 ofe I %\/Clear ‘ zNote l @Help [ [> Run
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Batch processing

This allows to process both images at the same time.
- Click on Add all
- Make sure to refresh

S

File Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help
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¢ = [2] S2A_MSIL2A_20180730T090551_MN0208_R050_T34SFH_20180730T12042!
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S2A_MSIL2A_201B0730T. 3
=z
=
]
L=
]
3
F=
z
o
! @
4 [T» 3
s
Navigation - ... X | Colour Manipul Uncertainty Vis... | World View w_band_3 = a
= s a
-}

2 Products

Target Folder
BEAM-DIMAP

Save as

Directory:
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|| Skip existing target files [v] Keep source product name

Load Graph Close | Help
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Resample

e Select a reference band: B2 at 10 m.
* Resampling method: Bilinear

- [/shared/Training

j [2] B12 [S2A MSILZA 201807307T090551 NO208 RO

File Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help Q-
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¢ i [2]) S2A_MSIL2A_20180730T090551_N0208_R050_T34SFH_20180730T12042!
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o (3 Masks ¥ : /O Parameters | Resample Subset BandMaths | BandMerge

Define size of resampled product
B2
® By reference band from source product: Resulting target width 10980

Resulting target height: 10980
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=
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) By ) a
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Downsampling method First

Flag downsampling method First
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Subset

e Select bands: B3, B8, B12, Cloud_mask

» Select Geographic coordination
* Clickon A, zoom in to the area of interest

Select a yellow box within the red square
l 3 - [52A MSIL2A 201807307T090551 NO208 RO50 T34SFH 20

File Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help
a® 9 Fhd PoRQ /2 WOWBW T D& HE
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NOTE 2: The most commonly used metrics for burned area and burn severity mapping, derived from
satellite data, is the normalized burn ratio (NBR).

Band Math v

Healthy vegetation has very high near-infrared reflectance and low reflectance in the shortwave
infrared portion of the spectrum. Burned areas on the other hand have relatively low reflectance in the
near-infrared and high reflectance in the shortwave infrared band. A high NBR value generally indicates
healthy vegetation while a low value indicates bare ground and recently burned areas.

* Go to “Edit Expression”

@ EXPLOITING SPECTRAL RESPONSE CURVES
* NBR: Normalized Burn Ratio: K o
(B8-B12)/(B8+B12)
‘0 ELECTROMAGNETIC SPECTRUM (wareinge pm) e

VISIBLE NEAR INFRARED (NIR) SHORTWAVE INFRARED (Swl%)
Credits: U.S. Forest service

m [2] B12 - [S2A_M5IL2A 201B0730T080551 NOZ0B RO50 T345FH_20180730T120425] - [/shared/Training/doy 20180730T120425.zip] - SNAP.
File Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help Q-
. : gl ] W ¢ t Boa GCP & SliEs
a% e Jfdd PR A UOBNKL X QDEG KB s o AN TRY: | v
Product Explorer X | Pixel Info = [ [ 11] Sentinel 2 MSI Atmospheric penetration RGE x 4r|[=/O [ B (1] cloud_ mask xl LRI R =1){=
o & [1] S2A_MSIL2A_20180703T092031_N0208_R093_T34SFH_20180703T12102! 5 - bl
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o O} Metadata 3 s s a
o @ Index Codings - Batch Processing yGraph_Greece wi E
o @2 Vector Data File Graphs 3
o (@ Bands
o B3 Masks /O Parameters ‘ Resample | Subset | BandMaths | BandMerge
Target Band: [nBR s
5
Target Band Type: [float32 2
Band Unit: [ =
E
No-Data Value:  [0.0 H
a
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m Arithmetic Expression Editor =
=
p . Data sources: Expression: J
q I [1] . B3 o {88 - B12) / (B8 + BIJ) z
Navigation - ... X | Colour Manipul... | Uncertainty Vis... |World View El | [ (2] Sentinel 2 MS| Atmo B8 C e-8 | H
B12 2
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[¥] Show bands Operators.. .

Functions...
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Band Merge

* Keep the source bands: NBR, B3, B8, B12, cloud _mask

[2] B12 - [S2A MSIL2A 2018073070905 NO208 RO50 T34SFH 201807307T120425] - [/shared/Training/downloads/S2A MS|

S2A_MSIL2A_20180730

File Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help
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5 A kod PR

Product Explorer X | Pixel Info El|“ @ (1] Sentinel 2 MSI Atmospheric penetration RGB x 4| »|>||O] [ B8 (1) cloud_mask xi »|[~|o]|g
o- & [1]) S2A MSIL2A 20180703T092031_N0208_R093_T34SFH_20180703T12102! 3 a)
¢ & [2] S2A_MSIL2A_20180730T090551_N0208_R050_T34SFH_20180730T12042! cé.
o @) Metadata f ; N 3 & 2
o @ Index Codings ‘?' . l Batch Processing : myGraph_Greece_with_subset.xml g
o (@3 Vector Data \ File Graphs g
o (@ Bands "
o (@ Masks e I/O Parameters | Resample | Subset | BandMaths | BandMerge
Source Bands: NBR: Subset S2A MSIL2A_20180703T092031_N0208_R093_T34SFH_20180703T121025 resa S
|B3::Subset_S2A_MSIL2A_20180703T092031_N0208_R093_T34SFH_20180703T121025_resam E
|B8::Subset_S2A_MSIL2A_20180703T092031_N0208_R093_T34SFH_20180703T121025_resam ]
B12::Subset_S2A_MSIL2A_20180703T092031_N0208_R093_T34SFH_20180703T121025_resa 5
|cloud_ mask::Subset_S2A_MSIL2A_20180703T092031_N0208_R093_T34SFH_20180703T1210 =
3
&
3
<] [T»] =
z
Navigation - X | Colour Manipul Uncertainty Vis World View (= [ u (2] Sentinel 2 MSI Atmo g
= a
@ 3
e
N
@,
%
%

Load Graph

X =¥ - Lat - Lon - Zoom - Level - ° 2
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Running and visualizing the NBR band

B

File Edit View Analysis

a | D@L b o

Layer Vector Raster Optical Radar

Tools Window Help

v A er Al © I8 w |#£ X

El ("H 31 NBR x|
[a]

A\‘
Product Explorer X | Pixel Info
¢ W [3]1 S2A_MSIL2A_20180703T052031_N0208_R093_T34SFH_20180703T121025
o (2 Metadata
o (@ Vector Data
¢ & Bands
NBR
B3 (560 nm)
B8 (842 nm)
B12 (2190 nm)
cloud_mask
¢ & 4 S2A_MSIL2A_20180730T090551_N0208_R050_T34SFH_20180730T120425 |
o (33 Metadata |
o (33 Vector Data
? ‘S Bands
NBR
B3 (560 nm)
B8 (842 nm)
B12 (2190 nm)
cloud_mask

Navigation - [3] N

X | Colour Manipulation Uncertainty Visualis World View

TERPLLPL
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Try a color table:
* Colour manipulation: Open color table, choose a
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Collocation

Raster->Geometric Operations -> Collocation

e Select the two new images, give a name, rename source product

m Collocation
File Help

Source Products
Master (g arved):

] S2A_MSIL2A_20180703T09203T™WQ208 RO... |w

Slave ipixel values are resampled onto }he master grid):

4] S2A MSIL2A 20180730T090551L 208 RO... |+ |

Target Produc

Name:

S2A 20180703 20180730
(I D

] Save as: |BEAM-DIMAP |v

Directory:

fhome/rus/shared/Training/Greece_test |

w| Open in SNAP

Renaming of Source Product Components

#| Rename master components: RIG%L MAME} before|

#| Rename slave components: QR

L MAME} after
Resampling

Method: INearest neighbour resampling lv

Run | Close

0 xX

m [5] S2A_20180703_2018073(

Eile Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help
a% 9D

Product Explorer X | Pixel Info
o W [3] 52A_MSILZA_20180703T052031_NOZ08_R0O53_T345FH_20180703T121025
o a [4] S2A_MSIL2A_20180730T090551_NO0208_R0O50_T345FH_20180730T120425
¢ & [[5] S2A_201B0703_20180730|
o (O Metadata
o [ Flag Codings
- D Vector Data
¢ &3 Bands
B rBR_before
B B3_before (560 nm)
B Bs_before (842 nm)
B B12_before (2190 nm)
B cloud_mask_before
. RBR_after
B B3_after (560 nm)
B B8_after (842 nm)
B B12_after (2190 nm)
B cloud_mask_after
@ collocation_flags

Navigation Colour Manipulation X | Uncertainty Visualisation World View

This tool window is used to manipulate the
colouring of images shown in an image view.
Right now, there is no selected image view,

I [
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Create a water and cloud mask 2

| NOTE 3: The Normalized Difference Water Index (NDWI) proposed by McFeeters” is designed to:

maximize the reflectance of the water body in the green band; minimize the reflectance of water body
in the NIR band. McFeeters's NDWI is calculated as:

Green — NIR B B3 — B8
Green + NIR B3 + BS

NDWI =

Visible | Near- Mid-infrared

(o)
o
I

B O
T

()
?

Reflectance (%)
w
T

—
P

T T [ | | | | | [ ™
05 07 09 11 13 15 17 19 21 23 25
Wavelength (um)
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Create a water and cloud mask /2

* Click on the newly created stacked product [5], select BandMaths

* Cloud_water_mask

* Make sure to deactivate “Virtual”. We want to store the data!

Expression: 1 £
— B8 June) /

(cloud mask June > 0 or cloud mask July > 0 or
(B3 June + BS June))>= 0.0} then 1 else O

((B3 June

o i@ [2] S2A_MSIL2A_20180730T090551_N0208_R050_T34SFH_20180730T120425
o @ [3] S2A_MSIL2A_20180703T092031_N0208_R093_T34SFH_20180703T121025
o & [4] 52A_MSIL2A_20180730T090551_N0208_R050_T34SFH_20180730T120425

¢ = [5] S2A_20180703_20180730

o [ Metadata

o= [:l Flag Codings

o= D Vector Data

¢ &3 Bands
B RBR_before
B B3_before (560 nm)
B B8 _before (842 nm)
B B12_before (2190 nm)

B RBR_after

B B3_after (560 nm)
B B8_after (842 nm)
B B12 after (2190 nm)

Navigation

B cloud_mask before ‘

Colour Manipulation X | Uncer

Target product:
[5] S2A_20180703_20180730
Name: cloud_water_mask

Description:

Unit:

wavelength:|0.0

[ virtulll (save expression only. don't store data)

Band maths expression

Load... Save..

Cancel

Edit Expression...

NaM

Help

Band Maths Expression Editor

Product: {[S] S2A_20180703_20180730

Data sources

$5.RBR _before
$5.B3 before
$5.88_before
|$5.B12_befare
|$5. cloud_mask_before
|$5.RBR_after
$5.B3 after
$5.B8 after
[¥] Show bands
O

O

[] Show single flags

-

@+e

@-e

@*+e

@ase

i@

Constants. .,

Operators. ..

Functions...

I_VIQ:}\S|

&
Expression:
if ($5.cloud_mask_before = 0 or
$5.cloud_mask_after = 0 or
(($5.B3_before-
$5.B8_before) /($5.B3_before +
$5.88 before))>= 0.0 ) then 1 else g

Ok, no errors,

e J[zp]

L
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The masked map

]

File Edit View
|

Product Explorer

i

o=

- |

o- i@l [3] S2A_Ms

o i@ [4] S2A_MSIL2A_20180

e
[5] cloud_water_mask - S2A_20180703_20180730 - /shared/Training/Greece_test/S2A_ 20180703 _20180730.dim - SNAP

Anal Vector Raster Optical

Layer

X | Pixel Info

SIL24_20180

30T090551_N020 18073071204

I5] S2A_20180703_20180730
o (3] Metadata
o= (3 Flag Codings

o [0 Vector Data
7 ’a Bands
B RBR_before
B B3_before (560 nm)
B B8 _before (842 nm)
B B12_before (2190 nm)
B cloud_mask_before
B RBR_after
B B3_after (560 nm)
[+ )
B B12 after (2190 nm!
Navigation - [5] clou... | Colour Manipulati.. X | Uncertainty Visualis... |World View
Editor: Basic @ Sliders Table

Name: cloud water mask
Unit:

Min: 0.0

Max: 1.0

Rough statistics!

Pl WO @ME S|4

Radar Tools Windew Help

723

B B8 (5] cloud_water_mask =|

-

4

] 13RS
1o 3

&
£
=
&

® @7
g 4D T

® More Optlons

222 O

Lat

- Lon -

<<
<
<

Adeaqr 3anpodd

sabeuen sade ([

dabeue ysen [‘J

Zoom — Level —
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Mapping burned areas and burn severity

To identify recently burned areas and differentiate them from bare scil and other non-vegetated
areas the difference between pre-fire and post-fire NBR, the delta Normalized Burn Ratio (dNBR) is

frequently used.

dNBR = NBRyre—rire — NBRpost—rire

However, the dNBR is an absolute difference which can present problems in areas with low pre-fire
vegetation cover, where the absolute change between pre-fire and post-fire NER will be small. In
such cases the relativized version of burn severity is advantageous. In this tutorial we will use the
Relativized Burn Ratio (RBH}E.

RER — ( dNBR ) . (NBRpre—fEre o NBRpast—fire)
(NBRyo—fire + 1.001) (NBR, e—ire + 1.001)

Target band: RBR

Expression: if cloud water mask == 0 then ((NBR June - NBR July)/(NBR June +

1.001)) else NaN
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Relative Burn Ratio: RBR

°* RBR

Apply the expression in case no cloud & water:
Make sure to deactivate “Virtual”. We want to store the data!

Click on the newly created stacked product [5], select BandMaths

Expression: if cloud water mask
1.001)) else NaN

0 then

((NBR June - NBR July)/(NBR June +

8 |

Target product:
[5] S2A_20180703_201B0730

-
Name RER
Description:
Unit:
cpactral wavelength:|0.0
[ Ivirgual (save expression only, don't store data)
l NaM

Band maths expression:

Load.

Sawve..

Edit Expression

B

Product: [[5] S2A_20180703_20180730

Data sources:
-55.RBR_before

$5.63 before

$5.88 before

$5.B12 before
$5.cloud mask before
$5.RBR_after
$5.B3_after
$5.B8_after

|¥] Show bands

| Show single flags

-

Band Maths Expression Editor TN S

Expression;

@+ @ 1f $5.cloud water _mask == 0 then
(($5.B3 before-
@-@ $5.RBR_after)/($5.RBR before + 1.001))
ar+e else NaN
e/ @
(@
Constants... -
Operators. .. -
Functions. .. -

0k, no errors

Help
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Show the RBR in a color table

Open the RBR band

Lets change the colors: Color manipulation

Open color table: gradient_red_White_blue

Play a bit with the boundaries

File Edit View

Product Explorer

Analysis Layer

Pixel Info X

Vector

Raster Optical

P =

Radar Tools Window Help

QA WOB K 2| DG

SNAP

= B (5] cloud_water_mask x ﬂ 5] RBR x

Navigation - [5] RBR

Editor: () Basic

| Snap to selected pin

®) Sliders

Table

Colour Manipulation -

~| Position

Image-X Invalid pos.|pixel
image-y Invalid pos. pixel
Longitude Invalid pas"degrs—e
Latitude Invalid pos“degree
Map-X Invalid pos.|m
Map-Y Invalid pos.|m 1
+| Time

—] Bands

cloud_water_mask Invalid pos
RBR Invalid pos

+| Tie-Point Grids

| Flags

X | Uncertainty Visualisation World View

»

More Options

Name: RBR \

Unit
Min: -0,843

Max: 1.045
Rough statistics!

GCP
+

NVE9

Q-

<«

Zoom - Level -

Jabeuey Jake [m Aleiqr) 39npoud <«

dabeuep ysep
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Let’s try to restrict to only burned areas

We will create another band that will only contain burned areas. We will set the threshold for pixel to be
classified as burned to > 0.27.

* BandMath: RBR_
* No-Data Value: NaN
* Expresion: if RBR > 0.27 then RBR else NaN

* Make sure to deactivate “Virtual”. We want to store the datal!

E‘ Band Maths TaE %

Target product:
I[2] 524_20180703_20180730 v|

Name: RBR_ |
Description: |
|
|

Unit:

pactral wavelength:|0.0
@ ual (save expression only, don't store data)
” Na|

Band maths expression:
if RBR = 0.27 then RBR else NaN

Load... Save, Edit Expression... |

QK Cancel | Help |
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Export as geoTIFF

* File -> Export -> GeoTiff
* In Band Subset, select only: RBR, RBR_
* Select No flag dataset

a%| 9 4 d P2 Bau®@il = % i ™ 20 ANV R Q-
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Vizualization in QGIS

e Click on the Add Raster Layer
* In Band Subset, select only: RBR, RBR_

0y
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

DB &L f PLLHRPPLAL I 8- EE I & T-H

——'|Browser Panel

> T*0

Home

Favourites

/

DB2

MSSQL

PostGIS

SpatiaLite

& ArcGisFeatureServer
@ ArcGisMapServer

@@
i e

8
«
\EVED

3

[
Pon 4
4

A7 ows
VE.: & & Tile Server (XYZ)
WCs
’5; WFS
Y"l H WMS
Vo
—
Layers Panel

vBOTE-RAD
Sl V] subset S2A 20180703 201807...
-0.327416
0.409114

3 7,
s e S

Coordinate [ 675408,4215685 % scale[T135153 @ Magnlﬁerl o €@ :] Rotation [0.0 =] ¥ Render () EPSG:32634 @
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Lets color-scale according to USGS classification
table to interpret the burn severity (dNBR)

MOTE 4: The United States Geological Survey (USGS) prupused a classification table to interpret the burn
severity (dNBR), which canm be seen in the table bel-::w In our data the lowest value i -0.08,
demonstrating that there were no values related to detectable regrowth. The large number of
ambiguous pixels (yellow) is caused by the one month difference between our pre- and post-fire images.
Due to the severe drought the vegetation likely degraded significantly between these two dates
producing similar NBR difference as low severity burn.

While we are using RBR and not dNBR, we will apply the same classes as defined below for visualization.

It is generally difficult to derive the burn severity without ground data to relate the values to.

Severity Level dNBR range (scaled by 10°)  dNBR range (not scaled)
Enhanced Regrowth, high (post-fire) -500to0-251 | -0.500 1o -0.251

Enhanced Regrowth, low (post-fire]  -250 to -101 | | -0.250 to -0.101

Unburned 100 1o +50 [N -0.100 to +0.099

Low Severity +100 to +269 | I +0.100 to +0.769
Moderate-low Severity +270 1o +439 | +0.270 to +0.439
Moderate-high Severity +440 to +659 _ +0.440 o +0.659

High Severity +660 to +1300 NG -0 660 to +1.300

Credits: UN-5PYDER Knowledge Portal
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Add the color table

Right-click the opened raster-layer in the Layers Panel (lower left) -> Properties

In Style set: Singleband pseudocolor, Discrete

Click on Load color map from file. Navigate too the Auxdata folder, open: Colour_pallete_RBR.txt

7

o

QGIS 2.18,23

Project Edit View Layer Settings Plugins Vector Raster D:

Web Processmg Help

T T S

0 IDE%]I_*'O@}%@Q/ -

“ ’// [_" o - P £ D € [
——|Browser Panel & X
Vo [Qevto |
' ) E Home
& Favourites
L |28/
= DB2
@ - MssQL
@ PostGis
@' / SpatiaLite

@& ArcGisFeatureServer
- @ ArcGisMapServer

) OWS
i @ Tile Server (XYZ)

47 WFS
@ wMs

Layers Panel g x

& @V &AL

subset S2A 20180703 201807...

I None
High regrowth

1 Low regrowth
Unburned
Low severity
Moderate-low severity

; Moderate-high severity
High severity

Render type [singleband pseudocolor .

@@ Transparency
B Pyramids
|8 Histogram

: (i Metadata
e

Legend

Layer Properties - subset S2A 20180703_20180730 | Style

Band

»

Color

Interpolation |Discrete

Band 1 (Gray)
Min -0.327416

Max

|

|04409114

|

Style ~

Mode | o

Mode |Continuous v[

Label unit [
suffix
Min / max o S
origin: Estimated cumulative cut of full extent.
Value <= [Color [Label |
-0.5 [ _ None
-0.25 p High regrowth
-0.1 ~ Low regrowth
0.1 I Unburned
0.27 Low severity
0.44 Moderate-low severity
0.66 Moderate-high severity
13 High severity

R ST
Mcdlr rate-high se
nur seventy

AnCa

_I_J_I_I

& cralali735753

Conses [T

Mannifiar [ 1509, @ =

Rotation |o. 3: ¥ Render ) EPSG:3263¢ @
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Final RBR map

Overlay over Google Sattelite:
Web-> OpenlLayers plugin -> Google Maps -> Google Satellite

7 QGIS 2.18.23 [ATETTETK

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

IDOBRBLRAOPLPLRHEPP RSN S[aE |
“ y |ﬁl o0 D '_') :-;\ E] g B A m abe J' no abe nbé mf} abe “J:sw Hﬁ>
——

|Browser Panel B X
LRETRO |
G- [ Home
Favourites
&5 /
.8 DB2
MSSQL
@ PostGls
4 / SpatiaLite
@& ArcGisFeatureServer
@ @ ArcGisMapServer
v 7 OWS
+ & Tile Server (XYZ)
9 & wcs
a V) WFS

@ @ wMs

Layers Panel & X
< BOTVE-BAO

’ _ Imagery ©2018 TerraMetrics | Terms of Use
Coordinate|  2586241,4575726 5 Scale[1:231,068 x| @ Magnifier|150% @ = Rotation 0.0 =] M Render @) EPSG:3857 (OTF) @
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Visualizing only the Moderate to High severity areas

* In the Style tab set band to Band 2

e Load the color table
7 ClERNGEy e

Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

10 .—ﬂ_[lHi f;"ﬂwpxj I T’"\
=
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U } -~ e “ Y = =% 5 8 “w
——'|Browser Panel
VS R X
'r & Home
= Favourites
L |28
&8 pB2
'G 4 MSSQL
& @ PostGIs
SIA Y| - # spatialite
- & ArcGisFeatureServer
% - @ ArcGisMapServer
AP - ) OWS
~g0 € Tile Server (XYZ)
9 @ WCS
G -8 WFS

E @ wMs

Layers Panel

< "@ 0.7‘ "112
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omparison

Kineta, Greece | 2018-07-30

[Colour Infrared Imagery (NIR/Red/Green Bands) 4 #1
ontains modified Copericus Sentinel data [2018]. Imagery: Sentinel-2 | Analytics: BigDataEarth.com

Imagery.

* Burned area correctly detected.
* Burn severity quantified
* Some spots missed due to clouds and cloud shadowing
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